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1 ALMA ObsPrep UserTest 1 
 

This document describes the ALMA Observation Preparation subsystem 
UserTest1: the purpose of the Test session, the testers involved and their testing 
framework, an executive summary of the test results, the detailed test reports are 
appended to this document. All the testing material, the files produced by each 
tester and a copy of this document are available on the ObsPrep Twiki pages in the 
UT1 section (http://almasw.hq.eso.org/almasw/bin/view/OBSPREP/UserTest1). 

 
1.1 Purpose of the tests 
 

The goals of this first round of user tests for the Observation Preparation subsystem 
was mainly to get feedback on the Observing Tool design, in particular the main 
GUI structure and the “Tree” presentation and how easy the testers felt that their 
favorite projects could be set up for observations (the so-called Phase II).  
 
Additional items tested were: a possible installation technology based on the Java 
Web Start, the interaction with the local Project Repository, the Import/Export 
facility foreseen for project exchange between different Co-Is, and the Exposure 
Time Calculator module (not yet integrated within the OT). A demonstrative 
version of the “mapper” was also available. 

 
1.2 Testing conditions 
 

Each tester was given a package consisting of the SSR requirements for the 
ObsPrep subsystem, a questionnaire to guide the tests, an XML file for an example 
project to import in the OT, a detailed explanation on how the example programme 
was constructed and pointers to the User Guide on the ObsPrep Twiki web pages. 
The User Guide and the example also explained how to obtain and run the 
Observing Tool version released for the tests. The version released for the tests was 
tagged at UT1-1, no updates of this version were necessary during the testing 
period. The time frame given for the testers  to complete the test and return the 
reports was two and half  weeks, but it was expected that no more than two full 
days had to be spent by each tester on the actual testing. 
 

1.3 Testers 
   

The group of testers selected for UT1 was composed by two members of ALMA 
Computing/Science IPT the ObsPrep subsystem scientist and the SSR member 
responsible for computing user tests, and three external testers: 
 
Leonardo Testi – Arcetri – Subsystem Scientist for ObsPrep 
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Debra Shepherd – NRAO – SSR member, responsible for computing user tests 
Maite Beltran – Arcetri – External tester 
Jane Greaves – St. Andrews – External tester 
Fabrizio Massi – Arcetri – External tester 
 
The testers provided a variety of test platforms: various flavours of Linux, Sun 
Solaris, and Windows on workstations and laptops. Various different browsers 
were used for the installation procedure (Mozilla, Netscape, Internet Explorer). 

 
2 Test results 
 

There was consensus among the testers that the subsystem passed UT1. The actual 
testing time devoted to UT1 by each tester ranged from one to two and a half days, 
in agreement with expectations. In this section we summarize the main results and 
recommendations from the test, the detailed answers and notes from each tester are 
reported in the next sections. 

  
2.1 OT Appearance and general structure 

 
To receive feedback in this area was the main goal of these tests.  
 
In general the testers liked the framework and, with one exception, no critical 
problems were found in this area. Several minor bugs and suggestions are given by 
each tester, here we mention only the more important comments. 
 

1. The GUI presentation is too much “compartmentalized”. The relevant 
information for the observation of each single target is spread over many 
different panels, there is no possibility to have a clear and intuitive 
overview of the entire setup for a given observation. A presentation that 
allow an easier, quick look view of the observation for each target should be 
offered. 

2. Playing with the configuration options of the GUI may cause the system to 
crash. To recover, the .almaot directory has to be re-initialized. 

3. All configuration options should be in a separate menu from the “advanced” 
options.  

4. All configuration options should be saved on exit and restored when the OT 
is started again.  

5. The “Tree structure” is nice and flexible, but an easy, novice-user option to 
“add a target” which does not require the manual definition of TargetSpace, 
TargetArea and SpectralSetup should be provided 
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2.2 OT Installation 
 

The OT retrival and installation procedures provided for these tests were not what it 
is foreseen for the final distribution to the ALMA users. In particular, it was still 
necessary to install, start and stop the ACS components separately and in the 
correct order. The proposed technology based on the Java Web Start is however a 
possible option. Once the Java Web Start software was installed in the testers 
systems, there has been no problems in downloading and using the OT and the 
associated ACS components. The ACS and OT download and installation went 
very smoothly, except for a few minor points. The key problem identified in this 
area is: 
 

1. Availability and installation procedures of Java Web Start are still not 
mature enough. It is recommended to monitor the future developments and 
general availability of these technology in the coming years. 

 
2.3 Save/Open and Import/Export 
 

All these function worked properly, except for a few minor bugs that are listed in 
the reports. The two main problems encountered were: 
 

1. The interaction with the LocalRepository is too much rudimental at the 
moment. Other search options and more info on the stored projects should 
be provided. The desired enhancements are detailed in the reports below. 

2. The current format of the XML file is too cryptic for the user. It is 
necessary to expand the first parts of the file with some comment lines on 
the project, creation date and author. 

 
2.4 Exposure Time Calculator and Mapper 
   

No major problems were found in these areas, although it is recognized that a lot of 
work is still needed on the one side to integrate the ETC within the OT and on the 
other to provide a realistic mapping of the project to SBs. A few bugs were noted 
and can be found in the detailed notes below. 
 

2.5 Documentation 
 

The documentation was generally found adequate for the purpose of the test. A 
single-file printable version of the User Guide would have been appreciated. The 
Java Web Start documentation provided by Sun is clearly not adequate, if this 
technology will continue to be used, the ObsPrep team will have to supplement this 
documentation.
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3 ObsPrep UT1 Tester Report Files. 
   

This appendix contains the collated answers of all testers to the questionnaire that 
was presented to guide their tests. The text of the questionnaire presented to the 
testers is shown in boldface, the answers of the various testers are reported in 
Italics. The answers of each tester are identified by his/her initials. 
 

3.1 Tested system 
 
          DSS  Tester: Debra Shepherd  
                   System: Linux Redhat 9.0, Mozilla 1.4 
                               Windows, laptop (Dell), RedHat 9.0, Netscape 
                  Webstart Version: 1.4.2 
                                   Logfile: log.output (linux log) 
                             and: log.output.windows (windows log) 
                  NOTE: See also my personal testing.notes and bug.report.txt for 
                              details.  I mention specific items below if they are 
                              particularly important. 
 
          FMa  Tester: Fabrizio Massi  
                    System: Solaris 8  
                    Webstart Version:1.4.2_03(build b02)  
                                     Logfile: FMa_jws.log 
 
          JSG Tester: Jane Greaves  
                   System: enterprise linux 3 
                   Webstart Version: j2re-1_4_2_03-linux-i586.bin 
                                   Logfile: JSG_javaws_log 
 
          LTe Tester: Leonardo Testi  
                  System: Linux RedHat 9.0, Mozilla 1.2.1 (Some on Win XP with IE 6.0) 
                  Webstart Version: java version "1.4.2" Java(TM) 2 Runtime Environment,     
                                               Standard Edition (build 1.4.2-b28) 
                                               Java HotSpot(TM) Client VM (build 1.4.2-b28, mixed mode) 
                                  Logfile: LTe_jws_logfile 
 
          MTB Tester: Maite Beltran 
                    System: Linux, RedHat 7.3, Netscape 4.79  
                    Webstart Version: 1.4.2_03 
                                    Logfile: MTB_webstart.log 
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3.2 Obtaining and running the Observing Tool. 
 
   For this test is is necessary to download/start the ALMA Common Software 
   (ACS) components in the correct order before downloading/running the OT. 
   It is also important that the OT and ACS components are shut down in reverse  
   order at the end of the test. This is not going to be the final way of 
   running the OT. Our goal is to have a one-click download/start 
   of all components in the correct order (including all ACS stuff and the OT)  
   and have everything killed in the proper order when the "Exit" button is  
   pressed in the OT gui. However, apart from this 4-click startup and shutdown 
   what we are testing is a possible OT delivery technology. 
    
   Do you think that the WebStart technology as you have tested it fulfils the 
   ALMA-OT requirements? 
 
            DSS  Yes. 
 
            FMa  It surely meets them. On my W/S, it is a little bit slow to run all ACS       
                       components and start the OT. 
 
  JSG  yes - it runs the gui and isn't huge to install  
   
             LTe  Generally yes, but some effort is needed to support the installation  
                     of the Java Web Start software (see below). 
 
                     A problem is how to start the OT independently from the web page. 
                     One has to start the JWS manager (one has to find it in the labirinth 
                     of his/her laptop first!), then go to the downloaded applications 
                     and start them. 
 
                     Another problem is the installation directory and the ancillary directories 
                     and files. For the time being, the default is to have a plethora of  
                     directories and files in my home directory.  
                     Note: if I start jws from a different directory and then start the  
                     applications from there, at least some of the directories/files are  
                     recreated here ( cachedir/, CDB_Recovery.txt, and  Manager_Recovery/ ) 
                     this is a potential source of confusion and unwanted proliferation 
                     of files. 
  
             MTB -   I think so, in the sense that it offers an easy to use interface, and a  
                       good way to visualize the main aspects of the observation (targets,  
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                       spectral parameters,...). 
 
 
   Did you encounter problems during the download/installation? 
 
            DSS  yes - I did not have java 1.4.2 on linux - this was 
           required and it took a bit of testing to get everything 
            working correct ly.  Presumably, this will get easier?  
           Also, blackdown JAVA did not work, I had to use Sun JAVA.   
 
             FMa  My workstation has java 1.4 installed, but a Solaris OS earlier 
                       than solaris 7 which is at least needed to run JRE. This is 
                       stated in the JRE download web page. Hence, JWS did not run. It is 
                       maybe advisable to provide the ALMA OT - Web Start page with a test 
                       to check the SOlaris OS version. 
 
  JSG  yes, many! you can see my attached notes if you like... 
 
            LTe  yes: the linked sun sites did not worked properly.  
                          The "Java Web Start" link points to the Windows version, 
                          I tried to use the "Linux" link in that page but did 
                          not worked. I then moved to the "Sun's Java download page" 
                          link. The first link (J2EE 1.4 SDK for Windows/Linux/Solaris SPARC) 
                          gives a timeout, as the last one (Download J2SE v 1.4.2_03). 
                          I did managed to download the "Download NetBeans IDE v 3.5.1 with  
                          J2SE v 1.4.2 COBUNDLE" for Linux and installed it.  
 
             MTB -  I have downloaded the WebStart version for LINUX, and once you find               
                      where to find it, and which you should download, the installation is straight 
                      forward. However, it's not trivial to find the correct downloading link.  
                      I have downloaded and .exe file, .rpm, until I have found the .bin file  
                      easy to install file. I think more information should be given. In addition, 
                      I found a BUG in "http://almasw.hq.eso.org/almasw/bin/view/OBSPREP/ 
                      RunningTheObservingTool" .When to try to go to the link Java Web Start  
                      in section Preparation for Installation it says that is unable to find the 
                      server. 
 
   Did you find the installation instructions appropriate? 
 
 
  DSS  yes, except that instructions said that java 4.1.0 or  
           higher was all that was necessary but J2RE 1.4.2_02 was 
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           required.  
 
             FMa  Yes, although the Sun's Java download page is a mess. It is maybe worth 
                        advicing to search the page for J2SE v 1..4.2_03, where the link to 
                       JREs lies. 
 
   JSG  yes, but did not cover all possibilities - I downloaded the wrong  
           linux version, went down wrong part of java web site tree, got  
           a bit lost flicking between the instructions and the java site  
           web pages 
 
             LTe The only problem I had (except with the problems in downloading the  
                     J2SE) was with the browser configuration. It took me a while to find 
                     the "...javaws executable file in your Java Web Start directory" 
 
             MTB -  As I said before, once you download the correct version, the installation 
                       is very easy.  
 
   What other information would have been useful? 
 
  
 DSS  As stated above, more specific JAVA version info is needed. 
          Also, instructions about how to start up the second time  
          (e.g. how to start JAVA Web Start and select downloaded 
          applications).   
 
             FMa  Configuring the JWS for netscape 6.x/7.x must be explained 
                       slightly better.  
   
  JSG  very complete instructions, e.g. how to look for the file area 
           jre might be in, how to install a standalone version just in my  
           directory 
  
             LTe The exact location of the javaws in the installation tree of the webstart  
                     software. This is probably installation dependent, we need to fix  
                     this problem. 
    
             MTB -  The pages with the SUN downloads for the different platform is a little  
                       bit messy, so I think that in the ALMA Observing Tool page you could give  
                       a little bit more info, such as "Downloads and Instructions are under  
                      Download  J2SE v 1.4.2_03 - JRE". 
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   What kind of improvements in this procedure you think will be necessary 
   to meet the ALMA-OT requirements (excluding the 4-click start/stop business)? 
 
   
 DSS  As you mention - a one-click process.   
 
            FMa  At the moment, I do not see any major improvement. 
 
  JSG  Could NOT have down this without system manager help and he was  
           struggling quite a bit too - and this is a Starlink site that is  
           used to dealing with astronomy software setup. Java is a mystery to  
           me and to many people - on my own I would have needed a setup  
           wizard.  
 
             LTe The problems that I had show that we cannot rely on an outside distribution 
                     of the Java Web Start software. An appropriate version of this should 
                     be made available to the OT users (together with the appropriate  
                     documentation). Unless this technology becomes a standard feature of  
                     most common web browsers in the near future. 
 
                     It should be possible to have a default installation directory different 
                     from the home directory. 
 
                     It should be possible to define once for all the location of cache and  
                     recovery directories. To avoid uncontrolled proliferation. 
 
                     We should make it easy for the user to locate the starting script/command 
                     for the OT (and document it). 
 
             MTB -  I think that once you can download all packages as only one package,  
                       the installation should not present any problem.   
 
 
3.3 The OT appearance 
 
   Test various look&feels, perspective, fonts and other options 
   (the connection to the repository is not active for UT1). 
 
             FMa  The OT windows look still too much anonymous.  
 
 
   Did you have problems with any of these tests? 
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 DSS  Yes, see my list of bugs and enhancement requests.   
 
             FMa  Playing around with the "Look&Feel" and "Options --> appearance"                 
                       menus sometime causes the OT window to mess up and needs to restart it. 
                       The arrows to collapse and expand subwindows are too small in some 
                       selected appearances. 
 
  JSG  Have I broken something? I clicked on something in Appearance, and  
           now all the screen areas have disappeared and stuff like  
           alma.obsprep.editors... is written all over it. (May have just lost  
           connection, you did say it should be disconnected from network  
           which I haven't done. Now it won't load, it's stuck on reading  
           preferences model) 
 
                LTe  yes: - the Look&Feel is not saved when I stop and restart the OT 
                                  (it is always back to "Skin") 
                                 - subwindow modifications are not saved either 

                      - some Look&Feel have subwindow commands that are too small 
 

           MTB -  Yes indeed. As already reported on Jan 21 by Leonardo. The problem    
                       happened to me the first time that I have installed the program and before  
                       importing any file or before typing anything, I have played with the  
                       Look & Feels, changed the fonts size and Perspective, and I have quit  
                       the program (to have the new fonts working). Next time I have tried to run 
                       the OT locally, it has got stuck when reading the preferences model.  
                       Removing all the packages and downloading them again has not solved  
                       the problem. The problem has only been solved when deleting the whole  
                       .almaot directory and startin OT again. I have noticed that if you first type 
                       something (as the name of the project) and you save the program, or you 
                       import a previous created file, then the problem does not occur. 
    
                    -  Some BUGS: without changing the fonts size, only changing Perspective,    
                       Tab placement, Look & Feels, for a while, I have had to quit the program  
                       again because the subwindows have disappeared, remaining only letters.  
                      Try this:  import a program, then go through all Look & Feels, trying all  
                      them, then go and change Perspective, you get a mess and have to quit.  
                      What is more, next time you try to start OT get stuck again when reading  
                       preferences model. Again I had to removed the whole ./almaot directory to  
                       get OT started. 
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                    -  If you work with Perspective I, and import or open a project that has been 
                       saved with Perpective 2, Perspective I remains instead of changing to 
                       Perpective 2. Have to do it manually again. 
     
                    -  I had a program exported with a "metal" Look & Feels. However, when  
                       imported it was back to "skin". 
      
                    -  One thing I do not like is the fact that you have to quit the program to 
                       get the new fonts working. 
 
   Do you like the concept of "Perspectives"? 
 
  DSS  I can't tell.  I did try changing the windows sizes, layout 
         options, minimizing parts of the screen.  Always, the 
         bright yellow message box says:  
         You are now in perspective '1'.   
         This text never changed through out testing.  Was it 
         suppose to change?   
 
             FMa  yes, it is interesting.  
 
  JSG  what is it?  
 
              LTe  yes: Would it be possible/easy for the user to create his/her own 
                           perspective? If not it will be useful to develop a pool of  
                           perspectives based on program types and user experience. 
 
             MTB -  I do not see too much usefulness to the possibility of choosing. I would  
                       leave only one of them, having one or the other does not change  
                       considerably the program. Although, I personally prefer Perspective 2.  
 
   Note that subwindows are "resizable" and "collapsable", 
   have you tested this feature? 
 
  
 DSS  Yes, nice feature (except the collapse arrows got *really* 
        tiny after I changed the windows so I could barely see 
        them).   
 
            FMa  Yes, this seems to work nicely. 
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  JSG  resizable was ok; collapsable didn't work, couldn't get hold of the  
           arrows 
 
             LTe  yes. No problems here, except that in some Look&Feels (notably the "Skin"  
                           and "GTK" ones on my Linux) the collapsable bars are so thin that 
                           it is hard to catch the arrows with the mouse. If one collapses 
                           everything is also difficult to know what to click to bring up  
                           one particular subwindow. 
 
            MTB -  I have tested both features and they work, although the "collapsable"  
                       arrows are so small that sometimes it is not easy to click on them. 
 
   What would be your favourite perspective for different classes of  
   projects (such as simple 1-src projects, surveys, spectral scans, 
   total power, mosaics...)?  
   (This should not necessarily be one of the two proposed here. 
    Note that you may want to answer this and the other questions in this  
    section at the end of your test session when you will be more familiar with 
    the OT). 
 
  
 DSS  This is difficult to say, I used the Layout option 1 with 
        the 'Feedback' window minimized to give me more room to see 
        the 'Spatial' and 'Spectral' windows.  I also re-sized the 
        whole window to increase relative size of the 'Spectral' 
        window.  This seemed to work fine.  If you also increase 
        the amount of information displayed in the 'Spatial'  
        window, (e.g. combine target & region info), then this 
        would be even better.   
 
            FMa  This will be better evaluated when the visual capability of the spatial 
                       editor is implemented. The proposed perspectives seem good. 
     
             MTB -  Some suggestions for improvements are made throughout this report.  
                       However, I should say that in general I like Perspective 2 (with the tab  
                       placement in the top). However, as mentioned later, I think that the way it  
                        is now is too hierarchic. There are too mant sub-sub fields, and I would  
                        remove "Region of Interest", joining the branch with Region+Spectral  
                       Elements to Target Space. Also, I would differenciate between single fields  
                       and mosaics, or multi-fields. I suggest to put the coordinates of the target  
                       under Target Space. Then, for single field you would not need to give  
                       additional coordinates, just the size of the region. On the other hand,  
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                       under mosaicing mode you could give the offsets from the central position  
                       in the Region section. 
 
                    -  By the way, something missing now is the possibility of selecting the 
                       configuration. This option should probably be under Edit, or maybe some 
                       steps further in the tree. 
 
   What kind of improvements in this GUI framework you think will be  
   appropriate/necessary to meet the ALMA-OT requirements? 
   (This refers to the framework, perspectives, options, menus, 
    NOT on what is displayed in each subwindow which will be addressed below). 
 
 
 DSS  See my list of enhancements that address this point.   
        The most important one is (please consider this!): 
        - Things are way too compartmentilized - looks like the 
        modular programing structure is being imposed on the user 
                   (this is a major problem with the current user interface of 
        the aips++ software).  With so much of the critical program 
        information spread over many layers, it is difficult to tell  
        at a glance what is going on.  This is one thing I hate 
        about JOBSERVE, and AIPS++ tool organization.  I shouldn't 
        have to click on 10 to 20 links just to get an overview of a 
        project.  This just invites user error. 
 
             FMa  A help on the upper command bar should open its own window when 
                       invoked. 
 
  JSG  It's pretty nice compared to others I've seen (less cluttered).  
           I'm not that bothered about the exact visual appearance, so long 
           as a readable font size is available.  
 
                LTe  Perspectives: It should either be possible to edit (and save) your 
                        own perspective, or a pool of perspectives should be available. 
          
                         It would be more appropriate to restructure the Options and  
                         Look&Feel menus to separate the Appearance functions 
                         (now Look&Feel plus Appearance plus Advanced) from the  
                         Functionalities options (the connection submenu). 
 
                         It would be useful to save the status of the subwindows when exiting 
                         (now the size of the entire window is saved, but the relative  
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                         sizes of the subwindows is brought back to the perspective 
                         default at startup). 
 
                         The same is true for the content of the subwindows: 
                         if I select the view "Overview" in "Structure" then exit and restart, 
                         I would like to restart with the "Overview" view rather than the 
                         "Tree" one. 
 
                         It would be very useful to have the "title" of the subwindow displayed 
                         when is collapsed, either always or when the mouse is put on the  
                         "uncollapse" arrow. 
 
             MTB -  I was thinking that at the menu level, maybe it would be useful to have 
                       a Catalog option, which would allow you to link to all different kinds of 
                       catalogs, and even to a kind of ALMA archive, where you could find info 
                       about the regions or objects you want to observe. 
 
 
3.4 The program Tree Structure 
 
   The idea is to review whether the programme tree structure fulfills  
   the ALMA SSR requirements. Whether the hierarchical structure used to 
   capture the scientific inputs is appropriate and easy to use and at the  
   same time it allo ws the creation of complex programmes.  
   It should be noted that this version of the OT does not allow to delete 
   items from the project Tree and copy/move items is only supported with  
   "click and drag" using the mouse (no such functions appear in the edit menu). 
   These functions will be available in future versions. 
 
 
   Was it easy and intuitive to set up an observing programme using the  
   Tree structure? (if not why, and what kind of potential problems for which 
   type of programmes you see) 
 
  
 DSS  I had difficulty figuring out that I had to be in an active 
       project before I could create regions and spectral 
       information.  But, Every target needs a region and spectral 
       setup. Why not just attach region and spectral setup specs 
       to each TargetOfInterest block?  This would be easier.   
 
             FMa  Yes, setting up an observing programme was quite easy. 
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  JSG  No. Once the tree structure is in place it makes sense, but I did 
           not know where to start to do it. I think this is a general problem  
           (e.g. like the Gemini OT, the JAC OT...). This could be very easy  
           to fix, e.g. a window could suggest 'specify target area on  
           sky', 'add frequencies' etc. Without that the user will start at  
           random undesirable places - e.g. mapper, I would go there to pick  
           an area of sky because I know the co-ordinates I want! 
 
             MTB -  I like the tree idea, and once you get used it is easy to handle. Although  
                       I get lost with too many sub-spaces. For example, why do you have  
                       "Region Of Interest" and then "Region" ? Could not be both under the  
                       same line? You are not able to do anything under Region of Interest except  
                       typing  a Name. Name that you have to type again in Region. 
     
 
                    -  Regarding the Point Source Exposure Time Calculator, I think it would 
                       be more useful if you have it inside the Spectral Editor window. This way 
                       when you are filling this section with sensitivity, BW, ... you would  
                       immediately know how much time you are going to need. 
 
 
                    -  Something that is not mention in the manual is the possibility of adding  
                       Target Spaces, Regions and Spectral Elements using the right button of  
                       the mouse directly on the tree elements. You do not have to go to the Edit 
                       menu. 
 
 
   Did you test the "click & drag" functions to move or copy items? 
 
 
 DSS  No, sorry, forgot about this function.   
 
             FMa  Yes. Moving stuff from one ROI to another should be made possible 
                       not only by releasing the click on the targeted ROI label, but also by 
                       releasing the click on anyone of its elements in the tree structure. 
                       A trash symbol could be useful in order to allow removing elements 
                       by simply clicking and dragging them on it. 
 
  JSG  no 
 
             LTe  yes. I had the following problems: 
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               - I cannot duplicate ROIs within a given TS using the Click&Drag 
                (This may be useful to create a few TAs with same spec setup(s) 
                within a given ROI, then one can simply change the coords of 
                each ROI. 
               - I cannot duplicate TSs within the same project  
               - I could not drag and drop from another programme 
                (I opened two OT windows with different programmes to try this, 
                no error message was issued, but nothing was copied/moved either). 
 
            MTB -  Yes, I tested. However, it is not obvious that in order to make it to work  
                       you have to drag on "Region of Interest". If you try to drag it on 
                       "Spectral Element", it does not work. 
 
   Do you think that the proposed structure fulfils all ALMA needs? 
 
 
 DSS  Mostly - see the list of enhancements for details.   
 
             FMa  So far, it seems so to me. 
 
  JSG  If it will all be clearly laid out under Spatial and Spectral,  
           then it will probably all make sense. (How about polarization?  
           I think of that as another dimension...) 
 
        LTe  yes, but it is not yet simple enough for the novice user. You neet 
              to enter too much within the underline logic before being able to set up 
              something. Too many clicks to get to the end and it is not clear 
              where the end is (am I finished? Can I map to SBs now?) 
 
             MTB -  In general I think so. The way it is now is easy to use and visualize.  
 
   What kind of improvements to this framework do you think will be  
   appropriate/necessary to meet the ALMA-OT requirements? 
 
 
 DSS  Being able to see the region chosen against a fits image 
       supplied from local disk.  Will this be in the 'View'  
       option?  Will another window popup showing this overlay or 
       will the user just increase the relative size of the 
       'Spatial' window?   
 
             FMa  An on-line help would be a major improvement. 
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  JSG  It's hard to tell at the moment. I would like to see a few nice 
           clear tree branches: e.g. in spatial I enter the area I want to 
           image and am then offered single field or mosaic, and a choice of  
           angular resolutions. Then I go to spectral, pick my line frequency  
           and spectral resolution and get shown the integration time to a 
           particular sensitivity. I add polarization if I want it. Then I'm  
           done and happy... 
 
           At the moment it seems no user knowledge will be assumed and this  
           could be a mistake. I'm more likely to think ALMA's field of view  
           is such-and-such, I want to map a few arcmin, the blank sky  
           measurements will need to be taken over there... this is much more  
           intuitive than drawing a shape on an image - if we even have  
           all-sky submillimtre images to start from! 
 
     
       LTe  It is essential to provide a simple wizard interface to be activated 
             with a "add one target" button click. This should automatically create 
             a TS+TA+SS structure and will ask the basic questions on target, 
             resolution, spec setup and sensitivity. 
             This should be enough to map to SBs the observation. 
             The user shall be able to add or modify elements if needed. 
             For example, the user should be able to click on the TA and modify it 
             from circle to rectangle to something else if needed, mantaining the  
             basic parameters and SS(s) (without having to recreate another TA, 
             new Spec setups, and erase the old one). 
 
         MTB -  I have already mentioned some of them above. As a general suggestion,  
                       it would improve the OT to get some little help on the different parameters  
                       all over the tree and framework. I mean, you should be able to click on a 
                       parameter such as Bandwith, or Accuracy, or Sensitivity, or Name, or  
                      Pitch for the rectangle, and get some info about what does it mean, or  
                      allowed values, or units ... 
 
   Some aspects of the Tree presentation are still being discussed,  
   have a look at the web page 
   http://almasw.hq.eso.org/almasw/bin/view/OBSPREP/PresentationIssues 
   and express your view. 
 
 
 DSS  I like the Tree structure but I would like to see the region 
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         and spectral setup information attached to the 
         RegionOfInterest branch when it is created.  It is still 
         necessary to be able to add more regions or spectral setups 
         for a given target but at least the most common selection 
        (one target, one region, one spectral setup) will be covered 
        automatically.   
 
             FMa  The ROI appears redundant when there is only one ROI with more   
                       TargetAreas. But probably it is useful to have it on the tree structure when  
                       there are more than one ROI. 
 
   
        LTe  I agree to merge the ROI and TA.  
              More: the "Project" root is not really needed unless it is allowed to 
              open more than one programme within the same window. 
              I think that if a single window is allowed to open a single  
                       programme, then PhI and PhII could be two separate "tabs" in the  
              structure subwindow (so that not even the "Program" root is needed). 
 
           MTB -  As I already mentioned, I would more agree with the last structure  
                       proposed: 
                       "The user would see a TargetSpace consisting of the logical combination  
                       of  a TargetArea and a number of SpectralSetupElements."  
 
 
3.5 The Spatial and Spectral Editor Form(s) 
 
  When preparing the programme you will notice that when you click on different 
  items on the tree the forms in the editors change to reflect what input 
  are required at that level. Note that RA and DEC can only be entered as 
  decimal hours and degrees in this version. Please note what kind 
  of coordinates may be useful in your view. 
 
 
           DSS  0.0 
          00:00:00.000  
          00 00 00.000 
 
            FMa  Other formats should be also supported, like 00:00:00.00 and 
                      00 00 00.00 - 
 
  JSG  Traditional ones, i.e RA 00 00 00.0 Dec 00 00 00.0 or galactic  
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           000.00 00.0.  
 
             LTe  Eq, Galactic, Ecliptic. 0.0, 00 00 00.00, 00:00:00.00 
                      Plus offsets with respect to TS center (in arcsec,arcmin,deg,rad) 
 
             MTB - It would be nice to be able to input the coordinates in hh:mm:ss  
                       dd:mm:ss. 
 
  Experiment with the various parameters (also going out of the reasonable  
  range) and note any problems that you find.  
 
            FMa  No problem noticed  
 
  JSG  Entered my traditional RA and it lit up in red.  
 
             MTB -  BUG: I have put names to the Targets, Region of Interest, and Region,  
                       but they disappear when you open or import the file again. Also, if you  
                       choose a polygon as Region, the coordinates of the region do not get saved  
                       when you save or export the file. Regarding this polygon, I guess in the  
                       future it will be possible to define it (with the mouse?). The way it is now  
                       you have no idea what this region is. 
 
                    -  BUG: I have selected a Region with a declination of 58 degrees, and I  
                        have got no warning saying that this region is not visible for ALMA. This 
                       warning only appears when you use the Point Source Exposure Time  
                       Calculator. 
    
                    -  BUG: When you go with the mouse from one Spectral Element in one  
                       Region to another one in another region, the Spatial Editor does not  
                       change to the second. In order to get the Spatial Editor with the  
                       coordinates of the second region you have to go with the mouse and click  
                       on there. I think it would be a good idea that both, Spectral and Spatial   
                       Editors, change automathically when the mouse moves.  
 
                    -  BUG: If you type on Spectral Editor "Sensitivity = 10 mJy" (for example) 
                       and press return, and then you go to another Spectral Element, already 
                       created, to check something, when you return to the first Spectral Element  
                       the Sensitivity is on default again "-1". The value only remains if after  
                       giving the value to the Sensitivity you go to Name Correlator and press 
                       return there. 
 
  Are the parameters requested at the appropriate level? 
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 DSS  See bug/enhancement list for details.   
 
            FMa  The Opacity should be requested at each SpectralSetUp, not at the highest                       
                      level. 
                      Also, at least an "on-source integration time" field should be added at 
                      the SpectralSetUp form, allowing for an automatic computation of the total  
                      time which is requested at the target space level. 
                      Then, consider that different SpectralSetUps may require different    
                      preconditions within the same project. Now, all preconditions have to be  
                      entered at the highest level, but maybe some should be specified at the  
                       SpectralSetUp level. 
 
  JSG  They weren't really what I was expecting - if you compare my  
           entries to the example supplied, you'll see I put words instead of  
           numbers etc.  
 
             MTB -  Regarding Target Space, I do not think that this is the best place to put 
                       the Observation Time. Observation time should be some steps further.  
                       Maybe inside every Spectral Element or inside Region. 
 
                    -  Already mentioned, but I think it would be more useful to have the time  
                       estimate for a particular correlator configuration and source here that in 
                       the File menu (Exposure Time Calculator). 
 
 
  What kind of paramenters and at which level are missing for which type of  
  project? 
 
  
 DSS  Being able to change the relative spacing between pointings 
        in a mosaic.  
 
           FMa  See above. 
 
  JSG  Details are missing in the specification of the area I want? 
           For my program I had in mind to do a deep frame to look for a  
           disk around a brown dwarf, then image the area if one is found  
           to see if the line is just background gas. So I would be picking  
           offsets and stuff like that. Maybe the approach of drawing a  
           shape on an image will work, but it isnt what I'm used to.  



 
ALMA Project 
 
ALMA ObsPrep UserTest1 

 
Doc # :   ALMA-00.00.00.00-000-A-TTT 
Date:      2004-02-10 
Status:   Draft 
Page:      23 of 55 

 
 
           I was going to give more comments here but the OT is just  
           hanging in startup now so I've lost the window.  
 
      
       LTe  Project Level 
              - Is the "version" parameter useful (are different 
               versions saved/exported separately, does not seem to be the case)? 
 
             - These required parameters should be filled in automatically, or should  
               be asked to the user when a "new project" is created. 
 
             Program Level 
             - The meaning of these parameters is unclear. Most (all) of them are 
               relevant at the Spectrometer Setup level. A user can chose general  
               goals, but in most cases, the goals will have to be modified/refined 
               for every single observation (spatial resolution, freq setting, spec 
               setup, source, observing mode...). 
 
             - Modifying the ImagingScript also ControlScript changed 
 
             TargetSpace Level 
             - Need coordinates and size, plus menu option for what image (if any) 
               to show (DSS, 2MASS, other surveys?, own image) 
             - No integration time here 
 
             TargetArea Level (cosidered as merging of ROI and TA) 
             - Coordinates (absolute or relative to TS center, should start with default 
               to TS center) 
             - velocity or redshift 
             - required angular resolution (or should this be at spec setup level?) 
             - Mosaic options if any (or should this be at spec setup level?) 
             - Special observing modes options (or should these be at spec setup level?) 
             - I have choosen Polygon as a Target area. I “Add” ra and dec pairs but nothing  
               happens in the window on the left side above the Add/Delete buttons. 
 
 
             SpecSetup 
             - Integration time / sensitivity 
             - the form need to change based on the correlator constraints 
               (number of bands, resolution bandwidths, central freqs) 
             - Line lists and "FAS" (frequently asked setups) 
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             - Based on setup & velocity needs to return feedback on whether 
               the observations are feasible (within ALMA bands) or not. 
 
             MTB -  As a suggestion, and thinking about an easy way to create mosaics, I  
                       would put the coordinates RA and Dec of the Region in Target Space. I  
                       would remove the sub-area Region of Interest, keeping only Region with  
                       the associated Spectral elements. In Region I would give the coordinates of 
                       the different regions to study as offsets from the central position (whose 
                       coordinates are under Target Space). I think this way creating the  
                       observing file for a mosaic would be easier.  
 
                    -  In the Spectral Editor will be needed more parameters, such as the Vlsr,  
                       or number of spectral channels. 
 
                    -  Also it will be useful the possibility of importing files with sources 
                       coordinates, for big surveys. In such a case you would not need to type  
                       the coordinates by hand. 
 
                    -  It would be useful to have default correlator configurations for the  
                       Spectral Editor, such as continuum at different frequencies. It will also be  
                       useful to get the frequency for the spectral lines directly or by searching in  
                       a catalog.I think this has already been planned for the future.  
 
                    -  Maybe the number of channels needed is missing in the Spectral Editor? 
    
                    -  It would be nice to be able to give the spectral resolution in km/s as well. 
 
  What kind of improvements to this parameters presentation you think will be  
  appropriate/necessary to meet the ALMA-OT requirements? 
 
 
 DSS  See bug/enhancement list for details.   
 
            FMa  In the SpectralSetUp, the transitions should be ALSO made selectable  
                      through a list of allowed molecular transitions.  
                      Once chosen the transition, the other fields should  
                      show menus where to select the allowed values for that transition. 
                      The same should be made to allow an easy selection of calibrators. 
 
  JSG  I think observers will expect quite a lot more detail. Is this  
           going to expand a lot? An example based on JCMT observing might  
           be tweaking the frequency centre of the bandpass to get more  
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           lines in, defining the source velocity in a different  
           frame, altering the sideband to get better atmospheric  
           transparency.... It's nice if this can be done invisibly for  
           the total-novice-in-a-hurry but these issues actually matter  
           a lot of the time! 
 
     LTe See above 
 
 
3.6 The Save/Open functions in the File menu 
 
  These are used to save projects to the local (somewhere on your hard disk) 
  Project Repository. In future versions the Submit/Retrieve functions will 
  send to (or obtain from) the ALMA database observing projects. 
 
  At any time you should be able to save your programme, the top level  
  project info are required to save (PI, Name of Project, and Proj version). 
 
  Try to use the save function to save a few programmes in your repository 
  (you will need to set up different projects with various titles or PIs) 
 
             MTB -  I have tested it and it works. 
 
  Now you can try the open function. Try to find the project that you want to  
  load back and experiment a few times with the various options. 
 
             MTB -  I have tested it and it works. 
 
  What problems did you have with Save/Open (if any)? 
 
 
        DSS  File => save produces message: 
              Project UT1_example 1.0 stored to repository with  
              id =uid://X6bd88e532590ba00/X000000000  
              I can't cut and paste this huge id, if they are going to be 
              so complicated, at least allow the user to copy the id so 
              they can be cut  and pasted into a window.  This is supposed 
              to be saved to a local ProjectRepository but I'm not sure 
              where this is...  
 
            FMa  The Open menu allows to retrieve a project by PI or Project Name 
                      only if the whole string is entered. This should be possible also entering a        
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                      substring. 
 
  JSG  The example opened ok and my attempt seemed to save but since  
           the OT has utterly crashed I can't try re-opening.  
 
  
             LTe - Successive versions overwrite old one without warning (or previous  
               versions are not displayed when re-opening). 
 
            MTB -  When you save the project you are working on does not ask you if you  
                       want overwrite the previously saved project. Taking into that the search  
                       can only be made by PI name or Project name it is not possible to save  
                       different versions of the same project. You can only export them with  
                       different names. 
 
  What kind of searches you would like to do on the saved projects? 
 
 
 DSS  I'd like to search on spectral setups and names 
       (project/program).  
 
            FMa  By coordinates (indicating a matching radius). By date. 
 
  JSG  Target lists probably (object names).  
 
 
       LTe  - PI/CoI (partial matching) 
             - Name (partial matching) 
             - listall (range of dates?) 
 
             MTB -  Certainly by Source or Target is missing 
   
                    -  And the possible of visualizing all the projects saved locally. 
 
  What kind of additional info would you like to have (if any)? 
 
 
        DSS  All xml ==> difficult to read.  Is there anyway that some 
        basic project information can be written to a comment block 
        at the top of this file that is easier to read?  Also put in 
        a blank statement that this file can be imported to the 
        ALMA-ObsTool. 
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     LTe - PI, Name of proj, Version, Date saved, Status (draft prop, prop subm, 
           prop accepted, PhII draft, PhII submitted, PhII accepted for exec, 
           terminated) 
 
            MTB - Maybe the sources observed. It would be nice to get a basic list with the 
                      Targets observed in a project without having to open that project. 
 
  What kind of improvements of the interaction with the local repository 
  do you think are necessary (if any)? 
 
 
  DSS  See problem listed above.   
 
            FMa  The list of the content should be shown on demand. 
 
        LTe  - Possibility to delete projects, or old versions of them 
              - Possibility to export projects (directly)  
              - see above for others 
                       - The window with the ID information (when saving) is more scary than  
               useful (one may think that it is needed to save the ID somewhere) 
 
 
 
3.7 The Import/Export functions in the File menu 
 
  The Import/Export functions are used to write out (or read in) programmes 
  in a format that can be easily used to share programmes among Co-Is (e.g. via 
  e-mail). The format chosen is XML.  
 
  At any time you can click on the Project root in the Tree and the Export  
  function will be activated in the File menu. Try to export your programme  
  and Import the example.  
 
             MTB - I have tested and it works. 
 
  Together with the report you should make your exported project available  
  at the end of the test session. 
 
  What problems did you have with Import/Export (if any)? 
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  DSS  None.  
 
            FMa  No problems noticed. 
 
  
        LTe  None 
 
            MTB -  The only problem is maybe a BUG: when you export a program under  
                       an already existing name (file), it does not ask you if you can to overwrite  
                       the file. 
    
                    -  Also, when you want to export a project, you can only get the export  
                       option in the  File menu if you position the mouse on Project. It should be 
                       available from every position in the Tree. 
 
  What kind of improvements of these functions do you think are necessary 
  (if any)? 
 
 
        DSS  Again: All xml ==> difficult to read.  Is there anyway that 
        some basic project information can be written to a comment 
        block at the top of this file that is easier to read?  Also 
        put in a blank statement that this file can be imported to 
        the ALMA-ObsTool. 
 
  JSG  seems to be fine 
 
 
        LTe  It would be nice to have the possibility of exporting and importing  
              subsets of a project. e.g. I could have a collaboration with somebody,  
              I take care of the continuum mosai obs of something, he does the spectral 
              survey of something else. I could export my target space (with associated 
              TA, spec setup and constraints) and he could load it in the project. 
 
              If such thing is not possible, then the export function should work 
              at all levels of the hierarchy (not only when project is clicked). 
     
              Definitely, PhI and PhII should be exportable separately. 
 
             MTB -  I would resolve the just mentioned problems. The rest is fine. 
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3.8 The Exposure Time Calculator 
 
  With this version of the OT it is distributed also a preliminary 
  (but based on a sensible formulation) exposure time calculator for 
  point source detection in single field interferometric mode (similar to  
  what is available on the ALMA web pages at ESO:  
  http://www.eso.org/projects/alma/science/bin/sensitivity.html ) 
  Note that the atmospheric conditions assumed in this version of the  
  ETC are only those for the best 25% of the time (pwv<0.05mm), and that 
  the instrumental parameters (receiver temperatures, efficiencies etc)  
  are very rough numbers. Nevertheless, all other aspects should be  
  realistic and correct (the range of ALMA bands, effects of resolution, 
  elevation, number of antennas...). In future versions the ETC will be  
  integrated in the OT allowing internal calculation of integration times 
  based on spectral setup and vice versa. 
 
  Did you have problems running the ETC? 
 
 
 DSS  Yes, see bug report for details.   
 
             FMa  No. 
 
  JSG  no,it was fine 
 
  
        LTe  No; it would be nice to have parameters updated when return is hit 
               after typing in values. There should be a control on the number of digits. 
                        Bandwidth is confusing (it actually is "resolution" for spectral  
               observations) 
 
            MTB - BUG: When you change the parameters such as BW, and press return  
                       the Exposure Time does not get actualized unless you move to a different  
                       window such as Frequency for example, and click the mouse there. 
 
  What kind of improvements do you think will be necessary to the ETC? 
 
 
 DSS  I would like to have a button on the target page or such 
        that says, ExpTimeCalc - click on it and all the relavent 
        parameters for that target are uploaded to the ExpTimeCalc 
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       and the calculation is made. 
 
       For a target, I specify the observation time, why isn't this 
       linked to the sensitivity?  As it is, I have to run the 
       ExpTimeCalc find out reasonable combinations of sensitivity 
       and bandwidth, then input both these numbers manually (and 
       hope I got them right).  The obs time should produce a 
       sensitivity or vice versa. 
 
             FMa  Atmospheric conditions should be selectable (at least on a good-mean-low 
                       basis).  
 
  JSG  polarization data, bandpass as well as channel width, noise  
           at specified elevation, continuum versus line mode, list of 
           lines in bandpass, noise for different spatial reolution... 
 
 
        LTe  Needs to be integrated with the rest of the system 
 
             MTB - Already talked about this. I would probably move it inside the Spectral 
                      Elements.  
 
 
3.9 The mapper 
 
  The mapper function (in the file menu) allows to map your programme into 
  scheduling blocks. This is at a demonstrative level only in this version. 
  You can use the mapper for your satisfaction and see what happens  
  in the SB Editor view. 
 
 
 DSS  Nope, I could never get the Mapper to work in either Windows 
       or Linux versions.  I tried repeatedly (see testing log for 
        details).  Thus, I could never write SBs.  
 
  JSG  it worked 
 
 
        LTe  It worked... 
               I am wondering whether it will be possible to produce and submit 
               subsets of a program. 
               I think that the mapper function should be available in an advanced menu. 
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               In fact I think that the SB view should be activated only on demand  
               from an advanced menu and by default it should be a read only thing. 
               In the same advanced menu there could be an option to activate  
               the SB editor mode for expert users. 
               The file menu could contain a "verify" button and a submit button. 
 
             MTB -  I have tried and it worked (at this basic level). It puts all the targets 
                       as empty but I guess this is the way it should be at this stage.  
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4 Bug lists and notes  
     

Detailed testing notes and bug lists were produced by some of the testers and are 
appended below. 

 
 
4.1 DSS – Testing notes 
 
 
ALMA-OT Testing log 
Debra Shepherd 
2 Feb 04 
 
 
Required java installation to get ALMA OT to work on linux:  
setenv PATH /home/sola/j2re1.4.2_03/bin:${PATH} 
mozilla & 
 
I would like to have a single postscript file of the User Guide so I 
can just print it out and go through everything. 
 
------------------------------------------------------------ 
------------------------------------------------------------ 
Starting up on Linux:  
 RedHat 9.0, Mozilla 1.4 
 
My computer was pointing to java version 1.3.2 
Got sys admin to change the the path to point to version 1.4 
 
------------------------------ 
When starting Java Web Start, I get the error messages: 
 
Warning: Cannot convert string "<Key>Escape,_Key_Cancel" to type 
VirtualBinding 
Warning: Cannot convert string "<Key>Home,_Key_Begin" to type 
VirtualBinding 
Warning: Cannot convert string "<Key>F1,_Key_Help" to type 
VirtualBinding 
Warning: Cannot convert string "Shift<Key>F10,_Key_Menu" to type 
VirtualBinding 
Warning: Cannot convert string "<Key>F10,Shift_Key_Menu" to type 
VirtualBinding 
Warning: Cannot convert string "<Key>KP_Enter,_Key_Execute" to type 
VirtualBinding 
Warning: Cannot convert string "Alt<Key>Return,Alt_Key_KP_Enter" to 
type VirtualBinding 
 
Assume I can ignore these messages for now.   
 
------------------------------ 
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Error log is: /home/sola3/dss3/alma/tsts/obsprep/log.output 
 
 
Configuration DB: 
JAVA Web start window comes up but it is only 1cm x 1cm in size. 
When I click on the window then it becomes larger so I can see the  
 progress of the CDB, ACS install.  
 
Error: Unable to launch J2RE 1.4.2_02 Installer 
looks like a problem with different versions of java we have on our 
system.   
 
log.output says: 
 
Java Web Start Console, started Mon Feb 02 13:23:44 MST 2004 
Java 2 Runtime Environment: Version 1.3.1_02 by Sun Microsystems Inc. 
Logging to file: /home/sola3/dss3/alma/tsts/obsprep/log.output 
 
So perhaps Mozilla is still pointing to the wrong version?  
 
Tried to download the stand-alone Java Web Start to avoid the JRE 
problem.  
The download install.sh said that the JRE was not included.   
 
REQUEST: The documentation should say that the java code requires 
  JRE1.4.2 Our installation of JRE1.4.1 was not sufficient. 
 
Sys admin installed JAVA 4.1.2 on my system only (Blackdown JAVA) with 
proper JRE version. 
 
Configuration DB: 
Got the small window saying "close window to exit CDB" 
but then got messages  
 JAVA Web Start : Unable to launch CDB.  
 Unable to create int from strung >>null<<.  
 Please check property 
'jacorb.security.ssl.client.required_options' 
log.output says: 
 - Error - 
 java.io.StreamCorruptedException: invalid stream header 
 
One possibility: the blackdown-JAVA is causing problems?   
Try installing a Sun version of JAVA.   
 
Configuration DB: OK 
Manager: OK 
Containter: OK 
ALMA Observing Tool: OK 
 
Everything worked, got the expected error messages about security.   
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------------------------------------------------------------ 
------------------------------------------------------------ 
Starting up on Windows, laptop (Dell), RedHat 9.0, Netscape 
 
Configuration DB: OK 
Manager: OK 
Containter: OK 
ALMA Observing Tool: OK 
 
Everything worked, got the expected error messages about security.   
 
After installation, the download manager window said  
that the ALMA-OT was installed in  
        C:/DOCUME~1/DSHEPHER/LOCALS~1/TEMP 
 
 
------------------------------ 
------------------------------ 
------------------------------ 
Using ALMA-OT on windows laptop: 
 
In main window, clicking on 'Overview' tab shows  
text in grey - very difficult to see in 'skin' look&feel  
selection, other look&feel selections (metal,motif,windows) 
are impossible to see grey text.  
 
When the main OT window comes up, the 'Feedback' window reports: 
Warning: Too many target areas 
        clicking on >>> shows that the self-destruction sequence 
        initiated.  OH NO!!!!!   
Error: Parameter warp is out of range. 
        But hey, you don't tell me how to change the parameter 
        warp to avoid warp core implosion!  OH NO!!!!! 
        Now is this anyway to treat your users?   
 
No idea what it means to say: 
        You are now in perspective '1'.  
        Its in bright yellow so it draws the eye.  Why?  
 This text never changed through out testing.   
 
------------------------------ 
------------------------------ 
------------------------------ 
 
Using ALMA-OT on my Linux box: 
 
Switching between Application Layout option 1 => 2 => 1  
makes the tabs on the 'structure' block move from the  
 top => bottom => bottom  
Tabs stay on the bottom, why don't they go back to the  
top when moving back to application layout 1?   
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The little arrows which can minimize the different areas  
get *really little* (nearly impossible to see) after 
switching between Application Layouts.  
 
After importing the example xml file: 
---------------------------------------- 
File => save produces message: 
 
Project UT1_example 1.0 stored to repository with  
id =uid://X6bd88e532590ba00/X000000000  
I can't cut and paste this huge id, if they are going to be so 
complicated, at least allow the user to copy the id so they can be cut 
and pasted into a window.  This is supposed to be saved to a local 
ProjectRepository but I'm not sure where this is... 
 
The same message is produced whether I click the 'root' of the tree in 
the Structure window or whether I have clicked on a specific Target 
space.  Not sure what is going on.  Can't figure out where it is 
saved. 
 
Export to local disk worked OK.  All xml ==> difficult to read.  Is 
there anyway that some basic project information can be written to a 
comment block at the top of this file that is easier to read?  Also 
put in a blank statement that this file can be imported to the 
ALMA-ObsTool. 
 
There is no spectral information that I see associated with the example 
xml file.  
The xml file says this is a CO1-0 and 2-1 observing program so where is 
this 
information?  How do I access it?  Was it not loaded?   
 
Playing with Exposure Time Calculator: 
-------------------------------------  
 
As suggested in the User Guide, I changed the sensitivity to a 
negative number, then back again to the positive number it had 
0.04800000041723251 Now there are too many digits and the left side of 
the number is not visible unless I knock off some of the digits on the 
right. 
 
It would be nice to have the error messages or change in color and 
exposure time be modified when I hit return.  As it is, you have to 
click the mouse outside of the window you just modified to see the 
results. 
 
If I choose an invalid frequency band, shouldn't the exposure time 
show null or something?  As it is, it remains static from last 
calculation - this is confusing. 
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Creating my own project: 
------------------------ 
 
When I change the name of the project or program, I have to click on 
the folder in the Structure block and open and close the folder for 
the new name to be shown in the Structure tree.  Again, it would be 
nice if a mouse click outside of the field or hitting return would 
update the entire project views.   
 
In Program spatial editor,  
I modified the imaging script to read "mosaic" then I clicked on  
the TargetSpace and then back to the program window, now the 
Flow Control Script says "mosaic" too.  Why is flow control and 
imaging scripts forced to be the same?   
 
How do I figure out what control and preconditions are necessary?   
Could the documentation give at least some idea of what might be 
useful?   
 
Isn't 'seeing' and 'phase stability' essentially the same thing?   
 
It was not obvious to me how to create a 'region of interest' for a 
target space.  I would have prefered it to be in the same window as 
the TargetSpace.  Things are way too compartmentilized - looks like 
the modular programing structure is being imposed on the user (this is 
a major problem with the current user interface of the aips++ 
software).  With so much of the critical program information spread 
over many layers, it is difficult to tell at a glance what is going 
on.  This is one thing I hate about JOBSERVE, and AIPS++ tool 
organization.  I shouldn't have to click on 10 to 20 links just to get 
an overview of a project.  This just invites user error. 
 
It wasn't clear when I would get the spectral editor setup - I just 
kept clicking until I figured out that I had to click on a target 
region   
 
Having to assign a name to each part of a program and then manually 
pull up region and spectral information is confusing.  When I create a 
target I want templates for the spatial region and spectral setup to 
be generated automatically - also call them something reasonable.   
At first I changed the name of some level or other then I couldn't 
figure  
out what was the project, program, target, region, spec setup...  
 
Specifying a 'circle' - I want the option to just have a single field.   
 
Why is the ExpTimeCalc RA & Dec format different from the region spec?  
RA Dec should have the same options (e.g. single number, 00:00:00.000 
etc...).  Multiple input formats are good.   
 
I would like to have a button on the target page or such that 
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says, ExpTimeCalc - click on it and all the relavent parameters 
for that target are uploaded to the ExpTimeCalc and the 
calculation is made.   
 
ExpTimeCalc has bandwidth input, but this should be resoltuion.  
E.g. for a spectral line, the bandwidth might be 30 MHz 
but the resolution is only 0.1 MHz so you want to calculate 
the exposure time necessary for the chosen resolution. 
Terminology should be the same.  
 
For a target, I specify the observation time, why isn't this linked to 
the sensitivity?  As it is, I have to run the ExpTimeCalc find out 
reasonable combinations of sensitivity and bandwidth, then input both 
these numbers manually (and hope I got them right).  The obs time 
should produce a sensitivity or vice versa. 
 
Once when I tried to run file => export, the export option wasn't  
available. I clicked on the project, and both the target regions 
and the export option suddenly appeared.  
 
I exported the file once, then made some modifications, then exported 
the file again.  But: There was no dialog box warning me that I was 
about to re-write the xml export file.  I think there should be. 
 
OK, I just saved the program I created and quit the OT, manager, 
container, and CDB are all still active.  Now how do I restart?  Try 
going back to the web site and clicking on the 'ALMA Observing Tool' 
link.  My xload window shows that something happened but then there is 
no 
action otherwise. Perhaps I have to exit everything and then restart 
from scratch? 
 
Whoops, I canceled the manager, container, and CDB but apparently, I 
just had to wait for 5 minutes before the ALMA OT was ready to start, 
now I have the popup window that the OT is starting (says 'creating 
controller) but I just canceled things...  Who knows what is 
happening.  I can't seem to quit out of this load.   
Do I just have to wait for a time out?   
I quit mozilla.  ALMA Obs Tool is still trying to start... 
Frustrating.   
 
Try logging out and logging back in.   
OK, I don't see the process any more.   
 
There should be an easy way to abort the startup procedure.   
 
Start over: 
----------- 
 
Configuration DB: OK - odd, the little 'Exit CDB' window went to the 
tool bar 
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 but did not pop up on my screen.   
Manager:  OK  
Containter:  OK  
ALMA Observing Tool:  OK (previous size settings are saved) 
 
I now have cachedir/ and Manager_Recovery/ directories and a 
CDB_Recovery.txt file 
in the directory I started Mozilla.   
 
Imported g192.xml project 
 
The TargetSpace and RegionOfInterest names did not get saved.   
 Project, program, and spectral information names are all there.  
 
Changed a few thing (names, version number) 
 
Exported the file to g192-2.xml 
 
Tried to select File->Mapper 
 message: ERROR: Zero SBs specified... 
 But UserGuide says that choosing the Mapper will create the 
ObsUnitSets and SBs. 
 Tried to save the file (not just export it).  
 Mapper gives the same error.   
 
Enter Structure-SB Editor 
 Spectral Editor window remains frozen with last view 
 I don't think it should have a display unless it is active?   
 
The SB Editor says the program G192 is (empty) 
I clicked on every part of the project in the Structure window 
and tried to activate the Mapper.  I get the same error message.   
 Apparently I can't write SBs at all.   
 
See if windows laptop can read the project created by linux OT: 
 
------------------------------ 
------------------------------ 
------------------------------ 
Using ALMA-OT on windows laptop: 
 
Imported the g192-2.xml file 
        (lost TargetSpace, RegionOfInterest,Region names again) 
 
Tried to select the Mapper, same error as on linux:  
        Zero SBs specified.   
        Cannot write SBs in Windows laptop either.   
 
Exported the file to local directory, called it g192-3.xml 
 
Since I can't map the project to SBs, I guess I'm finished 
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        with network testing.   
 
Quit the OT 
Shut down the Manager, container, and CDB 
Shut down the web start application manager.   
 
Disconnect from the network. 
 
I found Java in C:/Program Files/Java/j2re1.4.2 (and j2re1.4.1_02) 
        click on javaws/javaws.exe 
        OK, started the JAVA web start application.  
View->Downloaded Applications.  
CDB start - OK 
Manger start - OK 
Container start - Manager panel now reports 2 exceptions: 
        - NoPermissionException 
        - CoreException (AbeansDataExchangeException).  
        Not sure what this means, container started.  
 
ALMA OT - OK 
 
Imported the g192-3.xml project - OK 
Still can't use the mapper but everything started OK... 
 
Shut down OT, container, manager, cdb, Java Web Start.   
 
End non-network testing.  
 
-------------------------- 
 
End testing.   
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4.2 DSS – Bugs list 
 
Bug report and Enhancement Requests for ObsPrep UT1 
Debra Shepherd 
2 Feb 04 
 
 
Bugs found: 
----------- 
1. In main window, clicking on 'Overview' tab shows text in grey - 
   very difficult to see in 'skin' look&feel selection, other 
   look&feel selections (metal,motif,windows) are impossible to see 
   grey text. 
 
2. Switching between Application Layout option 1 => 2 => 1  
   makes the tabs on the 'structure' block move from the  
 top => bottom => bottom  
   Tabs stay on the bottom, why don't they go back to the  
   top when moving back to application layout 1?   
 
3. The little arrows which can minimize the different areas get 
   *really little* (nearly impossible to see) after switching between 
   Application Layouts.  
 
4. File => save produces message: 
   Project UT1_example 1.0 stored to repository with  
   id =uid://X6bd88e532590ba00/X000000000  
   I can't cut and paste this huge id, if they are going to be so 
   complicated, at least allow the user to copy the id so they can be 
cut 
   and pasted into a window.  This is supposed to be saved to a local 
   ProjectRepository but I'm not sure where this is... 
 
5. Exposure Time Calculator: As suggested in the User Guide, I changed 
   the sensitivity to a negative number, then back again to the 
   positive number it had 0.04800000041723251 Now there are too many 
   digits and the left side of the number is not visible unless I 
   knock off some of the digits on the right. 
 
6. ExpTimeCalc: It would be nice to have the error messages or change 
   in color and exposure time be modified when I hit return.  As it 
   is, you have to click the mouse outside of the window you just 
   modified to see the results. 
    
7. ExpTimeCalc: If I choose an invalid frequency band, shouldn't the 
   exposure time show null or something?  As it is, it remains static 
   from last calculation - this is confusing. 
 
8. In Program spatial editor, I modified the imaging script to read 
   "mosaic" then I clicked on the TargetSpace and then back to the 
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   program window, now the Flow Control Script says "mosaic" too.  Why 
   is flow control and imaging scripts forced to be the same? 
 
9. Why is the ExpTimeCalc RA & Dec format different from the region 
   spec?  RA Dec should have the same options (e.g. single number, 
   00:00:00.000 etc...).  Multiple input formats are good. 
 
10.ExpTimeCalc has bandwidth input, but this should be resoltuion. 
   E.g. for a spectral line, the bandwidth might be 30 MHz but the 
   resolution is only 0.1 MHz so you want to calculate the exposure 
   time necessary for the chosen resolution.  Terminology should be 
   the same. 
 
11.Several times when I tried to run file => export, the export option 
   wasn't available. I clicked on the project, and both the target 
   regions and the export option eventually appears. 
 
12.When importing an exported file: The TargetSpace and 
   RegionOfInterest names did not get saved.  Project, program, and 
   spectral information names are all there. 
 
13.Mapper function did not work.   
   Tried to select File->Mapper 
 message: ERROR: Zero SBs specified... 
 But UserGuide says that choosing the Mapper will create the 
     ObsUnitSets and SBs.  
   I tried this in windows (on and off the network) and linux.   
   Perhaps I just did not get the procedure right?  If so, 
   documentation needs improvement.   
 
 
Enhancement requests: 
--------------------- 
1. It was not obvious to me how to create a 'region of interest' for a 
   target space.  I would have prefered it to be in the same window as 
   the TargetSpace.  Things are way too compartmentilized - looks like 
   the modular programing structure is being imposed on the user (this 
   is a major problem with the current user interface of the aips++ 
   software).  With so much of the critical program information spread 
   over many layers, it is difficult to tell at a glance what is going 
   on.  This is one thing I hate about JOBSERVE, and AIPS++ tool 
   organization.  I shouldn't have to click on 10 to 20 links just to 
   get an overview of a project.  This just invites user error. 
 
2. Having to assign a name to each part of a program and then manually 
   pull up region and spectral information is confusing.  When I 
   create a target I want templates for the spatial region and 
   spectral setup to be generated automatically - also call them 
   something reasonable.  At first I changed the name of some level or 
   other then I couldn't figure out what was the project, program, 
   target, region, spec setup... 
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3. Region selection: I want the option to just have a single field. 
 
4. I would like to have a button on the target page or such that says, 
   ExpTimeCalc - click on it and all the relavent parameters for that 
   target are uploaded to the ExpTimeCalc and the calculation is made. 
 
5. For a target, I specify the observation time, why isn't this linked 
   to the sensitivity?  As it is, I have to run the ExpTimeCalc find 
   out reasonable combinations of sensitivity and bandwidth, then 
   input both these numbers manually (and hope I got them right).  The 
   obs time should produce a sensitivity or vice versa. 
 
6. I exported the file once, then made some modifications, then 
   exported the file again.  But: There was no dialog box warning me 
   that I was about to re-write the xml export file.  I think there 
   should be. 
 
7. Spectral Editor window remains frozen with last view 
   I don't think it should have a display unless it is active?   
 
8. I would like to have a single postscript file of the User Guide so 
   I can just print it out and go through everything. 
 
9. Will users be able to change the relative spacing between beams? 
   Or will Nyquist spacing always be required.   
 
10.Probably isn't necessary to mention this but I assume the OT will 
   be expanded to include spectral line selection GUIs (e.g. graphical 
view 
   of the Lovas Catalog) and overlaying the chosen region onto a fits 
   file?  Hey, wouldn't it be nice to have the region displayed and 
   then be able to click and drag/rotate the corners until it looks 
   right?  This would be very impressive! 
 
11.All xml ==> difficult to read.  Is there anyway that some basic 
   project information can be written to a comment block at the top of 
   this file that is easier to read?  Also put in a blank statement 
   that this file can be imported to the ALMA-ObsTool. 
 
12. After the test, I finally figured out that the OT and ACS had     
    created 4 or 5 directories in my home directory.  This is not a  
    good plan.  If the OT needs some space, then put everything in a  
    single directory called ALMAObsTool or something obvious like this.   
    Also, please provide an estimate of the disk space required in the  
    documentation (so people know how much of their home directory will  
    be taken up). 
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4.3 FMa - Bugs 
 
1) OT 
Playing around with the "Look&Feel" and the "Options --> Appearance" 
menus sometimes causes the OT window to mess up. Quitting the OT and 
then starting it again causes it to remain frozen. 
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4.4 JSG – testing notes 
 
the installation process 
======================== 
 
went to http://www.eso.org/~mschilli/webstart-ot/ to get the download  
instructions 
 
a bit confusing about whether I need to download anything - we have 
java 1.4 (and I'm on enterprise linux 3) 
 
I got lost on the java web start download page (using Mozilla)  
because the link to linux download doesn't do anything... downloaded 
the linux version just in case 
 
(then found a note saying if we have 1.4 then I should already have the  
web start thing) 
 
click on the web start manager link to enable the log output but just  
get an 'unknown error'... have set up the javaws preference thing but I  
think it can't find it 
 
now it is time for coffee and track down the system guy... 
 
it took nearly an hour for him to install javaws - the Starlink version  
set itself up completely wrong, could not even find the config file in  
its own directory when explicitly pointed there! lots of problems with  
the APPHOME definition 
 
we ignored the starlink version, deleted my download, and got the 
proper one which is jre not the top link which was jse - now it is set 
up ok (thanks Tim!!!) 
 
now startup the OT parts - system guy is not happy about the blank  
certificate but we trust you guys....  ;) 
 
am I supposed to exit the manager before doing the next thing? it has  
some entries in the exception panel with cross symbols like things have  
failed (called core exception)... oops, I think I completely  
misunderstood this, it says 'wait for window that says 'close  
window'..., not to actually close it! hope I have closed them in the  
right order - start again leaving the windows up, now the exceptions  
have gone away 
 
(I object to being offered something called militarygame!!) 
 
looking good.... 
 
using the ALMA OT 
================= 
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like the not-many-things-at-once appearance of the OT screen 
 
the little arrows to collapse the feedback box dont seem to work, maybe  
they are so small I cant get the cursor on them? 
 
ok, I have named my program, how to set it up?  
as usual with OT's **it is not clear where to start!!!!** 
 
click about a bit, only the forms tab really has stuff in... (tabs are  
always a bit offputting, they neve seem to start with the obvious one,  
or even leap to the eye at all - maybe big descriptive buttons are  
better?) 
 
can I be working on more than one program at a time? I downloaded the  
example but want to try my own, and seem to have overwritten the 
example 
 
good, hints appear if you put the cursor in a box :) 
 
entered some random things in the spatial editor... with prompts from  
the webpage have added a target space and a region of interest - by now  
if this was for real it would be very baffling. The target space is a  
region ALMA will look at, and the region is interest is a shape like a  
circle? Huh? I want to cover a circular bit I've found in the digital  
sky survey or something? I was expecting something like a field of view  
and options to mosaic, am I not expected to know anything about the  
capabilities of the interferometer?  
 
it's nice there only 4 top menus each with only a few options, so the  
randomly clicking about method we all use works reasonably well... ;) 
 
why's it asking if I want to overwrite my program now I've clicked  
mapper? I just want to look at imaging tools or whatever! 
 
hmm, icon time... there's a square clock face, and a pile of clocks.  
Maybe they aren't clocks. They could be maps with folds in and a line  
pointing somewhere. Or sundials. Most like sundials, come to think of  
it. Anyway, we have the scheduling blocks there. 
 
the exposure time calculator is nice and simple. Bandwidth is a bit  
confusing, is that the whole passband or my desired spectral channel  
width? Later on I will want a polarization sensitivity too.  
 
soddit... tried changing the appearance and garbage came up on the 
screen and after running it all down (in the right order) the OT won't 
run up again. Eeek! 5 versions are now lurking not prperly run up and I 
can't stop them! 
  
Will log out from machine and see if this fixes something.  
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Nope, still won't start up. Sorry, out of time to try this. But it was  
interesting to do and has lots of good features! :) 
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5 Overall bugs list  

 
This is the compilation of all the bug reports from all testers. It has been compiled 
from the reports in Sect 3 and 4 for the purpose of offering a homogeneous 
reference list for the developers.  
 

1. In main window, clicking on 'Overview' tab shows text in grey - very difficult to 
see in 'skin' look&feel selection, other look&feel selections 
(metal,motif,windows) are impossible to see grey text. 

 
2. Switching between Application Layout option 1 => 2 => 1 makes the tabs on the 

'structure' block move from the “top => bottom => bottom”  Tabs stay on the 
bottom, why don't they go back to the top when moving back to application layout 
1?   

 
3. The little arrows which can minimize the different areas get *really little* (nearly 

impossible to see) after switching between Application Layouts.  
 

4. the Look&Feel is not saved when I stop and restart the OT (it is always back to 
"Skin") 

 
5. subwindow modifications are not saved either (they are always back to the 

fraction defined for that perspective). Not clear whether this is a bug or it is 
intentional. 

 
6. The problem happened to me the first time that I have installed the program and 

before importing any file or before typing anything, I have played with the  Look 
& Feels, changed the fonts size and Perspective, and I have quit  the program (to 
have the new fonts working). Next time I have tried to run the OT locally, it has 
got stuck when reading the preferences model. Removing all the packages and 
downloading them again has not solved the problem. The problem has only been 
solved when deleting the whole .almaot directory and startin OT again. I have 
noticed that if you first type something (as the name of the project) and you save 
the program, or you import a previous created file, then the problem does not 
occur. 

 
7. Without changing the fonts size, only changing Perspective, Tab placement, Look 

& Feels, for a while, I have had to quit the program again because the 
subwindows have disappeared, remaining only letters. Try this:  import a 
program, then go through all Look & Feels, trying all  them, then go and change 
Perspective, you get a mess and have to quit. What is more, next time you try to 



 
ALMA Project 
 
ALMA ObsPrep UserTest1 

 
Doc # :   ALMA-00.00.00.00-000-A-TTT 
Date:      2004-02-10 
Status:   Draft 
Page:      48 of 55 

 
start OT get stuck again when reading preferences model. Again I had to removed 
the whole ./almaot directory to get OT started. 

 
8. I have put names to the Targets, Region of Interest, and Region,  but they 

disappear when you open or import the file again.  
 

9. If  you  choose a polygon as Region, the coordinates of the region do not get 
saved when you save or export the file. Regarding this polygon, I guess in the 
future it will be possible to define it (with the mouse?). The way it is now you 
have no idea what this region is. 

 
10. I have selected a Region with a declination of 58 degrees, and I have got no 

warning saying that this region is not visible for ALMA. This warning only 
appears when you use the Point Source Exposure Time Calculator. 

 
11. When you go with the mouse from one Spectral Element in one Region to another 

one in another region, the Spatial Editor does not change to the second. In order to 
get the Spatial Editor with the coordinates of the second region you have to go 
with the mouse and click on there. I think it would be a good idea that both, 
Spectral and Spatial  Editors, change automathically when the mouse moves.  

 
12. If you type on Spectral Editor "Sensitivity = 10 mJy" (for example) and press 

return, and then you go to another Spectral Element, already created, to check 
something, when you return to the first Spectral Element the Sensitivity is on 
default again "-1". The value only remains if after giving the value to the 
Sensitivity you go to Name Correlator and press return there. 

 
13. I modified the ImagingScript also ControlScript changed as a result 

 
14. I have choosen Polygon as a Target area. I “Add” ra and dec pairs but nothing 

happens in the window on the left side above the Add/Delete buttons. 
 

15. File => save produces message: Project UT1_example 1.0 stored to repository 
with id =uid://X6bd88e532590ba00/X000000000 I can't cut and paste this huge 
id, if they are going to be so complicated, at least allow the user to copy the id so 
they can be cut and pasted into a window.  This is supposed to be saved to a local 
ProjectRepository but I'm not sure where this is... 

 
16. Successive versions overwrite old one without warning (or previous versions are 

not displayed when re-opening). 
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17. When you export a program under an already existing name (file), it does not ask 

you if you can to overwrite the file.  
 

18. When you want to export a project, you can only get the export option in the  File 
menu if you position the mouse on Project. It should be available from every 
position in the Tree 

 
19. Exposure Time Calculator: As suggested in the User Guide, I changed the 

sensitivity to a negative number, then back again to the positive number it had 
0.04800000041723251 Now there are too many digits and the left side of the 
number is not visible unless I knock off some of the digits on the right. 

 
20. ExpTimeCalc: It would be nice to have the error messages or change in color and 

exposure time be modified when I hit return.  As it is, you have to click the mouse 
outside of the window you just modified to see the results. 

 
21. ExpTimeCalc: If I choose an invalid frequency band, shouldn't the exposure time 

show null or something?  As it is, it remains static from last calculation - this is 
confusing. 

 
22. In Program spatial editor, I modified the imaging script to read "mosaic" then I 

clicked on the TargetSpace and then back to the program window, now the Flow 
Control Script says "mosaic" too.  Why is flow control and imaging scripts forced 
to be the same? 

 
23. Why is the ExpTimeCalc RA & Dec format different from the region spec?  RA 

Dec should have the same options (e.g. single number, 00:00:00.000 etc...).  
Multiple input formats are good. 

 
24. ExpTimeCalc has bandwidth input, but this should be resoltuion. E.g. for a 

spectral line, the bandwidth might be 30 MHz but the resolution is only 0.1 MHz 
so you want to calculate the exposure time necessary for the chosen resolution.  
Terminology should be the same. 

 
25. Several times when I tried to run file => export, the export option wasn't 

available. I clicked on the project, and both the target regions and the export 
option eventually appears. 

 
26. When importing an exported file: The TargetSpace and RegionOfInterest names 

did not get saved.  Project, program, and spectral information names are all there. 
 

27. Mapper has to work also for short integration times 
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28. Mapper function did not work. Tried to select File->Mapper message: ERROR: 
Zero SBs specified... But UserGuide says that choosing the Mapper will create the 
ObsUnitSets and SBs. I tried this in windows (on and off the network) and linux. 
Perhaps I just did not get the procedure right?  If so, documentation needs 
improvement.   

 
29. All unit changes should be reflected in the actual number entered by the user (e.g. 

if the user had enterd 1 in the integration time field and then changes the units to 
seconds the number should automatically change to 3600. 
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6 Overall Enhancements Request list  

 
This is the compilation of all the enhancements requests from all testers. It has been 
compiled from the reports in Sect 3 and 4 for the purpose of offering a 
homogeneous reference list for the developers 
 

1. Have a one-click download/startup 
 

2. Have an easy way to start the OT offline (without having to go to the webpage 
and/or start JavaWebSTart Manager and find the appropriate downloaded 
application 

 
3. Have a robust, easy and reliable way of installing JWS (if this is going to be the 

final technology used) 
 

4. After the test, I finally figured out that the OT and ACS had created 4 or 5 
directories in my home directory.  This is not a good plan.  If the OT needs some 
space, then put everything in a single directory called ALMAObsTool or 
something obvious like this. Also, please provide an estimate of the disk space 
required in the documentation (so people know how much of their home directory 
will be taken up). 

 
5. The OT windows look still too much anonymous 

 
6. It would be nice to save/export Perspective, Look&Feel and general preferences 

with the project 
 

7. One thing I do not like is the fact that you have to quit the program to  get the new 
fonts working 

 
8. Would it be possible/easy for the user to create his/her own  perspective? 

   
9. It was not obvious to me how to create a 'region of interest' for a target space.  I 

would have prefered it to be in the same window as the TargetSpace.  Things are 
way too compartmentilized - looks like the modular programing structure is being 
imposed on the user (this is a major problem with the current user interface of the 
aips++ software). With so much of the critical program information spread over 
many layers, it is difficult to tell at a glance what is going on. This is one thing I 
hate about JOBSERVE, and AIPS++ tool organization. I shouldn't have to click 
on 10 to 20 links just to get an overview of a project. This just invites user error. 
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10. Something missing now is the possibility of selecting the configuration. This 

option should probably be under Edit, or maybe some steps further in the tree. 
The required angular resolution is also missing. 

 
11. Region selection: I want the option to just have a single field 

 
12. …Detailed suggestions on the parameters and the level at which these should be 

requested… 
 

13. Moving stuff from one ROI to another should be made possible not only by 
releasing the click on the targeted ROI label, but also by releasing the click on 
anyone of its elements in the tree structure.  A trash symbol could be useful in 
order to allow removing elements by simply clicking and dragging them on it. 

 
14. I cannot duplicate ROIs within a given TS using the Click&Drag  (This may be 

useful to create a few TAs with same spec setup(s)  within a given ROI, then one 
can simply change the coords of each ROI. 

 
15. I cannot duplicate TSs within the same project  

 
16. I could not drag and drop from another programme  (I opened two OT windows 

with different programmes to try this, no error message was issued, but nothing 
was copied/moved either). 

 
17. Having to assign a name to each part of a program and then manually pull up 

region and spectral information is confusing.  When I create a target I want 
templates for the spatial region and spectral setup to be generated automatically - 
also call them something reasonable.  At first I changed the name of some level or 
other then I couldn't figure out what was the project, program,  target, region, spec 
setup... 

 
18. I like the Tree structure but I would like to see the region and spectral setup 

information attached to the RegionOfInterest branch when it is created.  It is still 
necessary to be able to add more regions or spectral setups for a given target but 
at least the most common selection  (one target, one region, one spectral setup) 
will be covered automatically.  

 
19. ROI and TA should be merged in the Tree presentation 

 
20. More on the Tree: the "Project" root is not really needed unless it is allowed to 

open more than one programme within the same window. I think that if a single 
window is allowed to open a single programme, then PhI and PhII could be two 
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separate "tabs" in the structure subwindow (so that not even the "Program" root is 
needed). 

 
21. I would like to have a button on the target page or such that says, ExpTimeCalc - 

click on it and all the relavent parameters for that target are uploaded to the 
ExpTimeCalc and the calculation is made. 

 
22. Coordinates: Eq, Galactic, Ecliptic. 0.0, 00 00 00.00, 00:00:00.00, Plus offsets 

with respect to TS center (in arcsec,arcmin,deg,rad)Also it will be useful the 
possibility of  

 
23. importing files with sources coordinates, for big surveys. In such a case you 

would not need to type the coordinates by hand. 
 

24. It would be useful to have default correlator configurations for the Spectral 
Editor, such as continuum at different frequencies. It will also be useful to get the 
frequency for the spectral lines directly or by searching in a catalog.I think this 
has already been planned for the future 

 
25. For a target, I specify the observation time, why isn't this linked to the sensitivity?  

As it is, I have to run the ExpTimeCalc find out reasonable combinations of 
sensitivity and bandwidth, then input both these numbers manually (and hope I 
got them right).  The obs time should produce a sensitivity or vice versa. 

 
26. The Open menu allows to retrieve a project by PI or Project Name only if the 

whole string is entered. This should be possible also entering a substring. 
 

27. Save: successive versions overwrite old one without warning (or previous 
versions are not displayed when re-opening). 

 
28. Open: I'd like to search on spectral setups and names (project/program).  

 
29. Open: Search by coordinates (indicating a matching radius).  

 
30. Open: Search by date. 

 
31. Open: Search target lists (object names).  

 
32. Open:  it should be possiblr to visualize all the projects saved locally. 
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33. Open: it would be nice to have displayed: PI, Name of proj, Version, Date saved, 

Status (draft prop, prop subm, prop accepted, PhII draft, PhII submitted, PhII 
accepted for exec, terminated) 

 
34. Open: It would be nice to get a basic list with the Targets observed in a project 

without having to open that project. 
 

35. Save/Open: it would be nice to be able to delete projects from the local repository 
 

36. I exported the file once, then made some modifications, then exported the file 
again.  But: There was no dialog box warning me that I was about to re-write the 
xml export file.  I think there should be. 

 
37. It would be nice to have the possibility of exporting and importing subsets of a 

project. e.g. I could have a collaboration with somebody,  I take care of the 
continuum mosai obs of something, he does the spectral survey of something else. 
I could export my target space (with associated TA, spec setup and constraints) 
and he could load it in the project.  If such thing is not possible, then the export 
function should work at all levels of the hierarchy (not only when project is 
clicked).  

 
38. Definitely, PhI and PhII should be exportable separately.  

 
39. Spectral Editor window remains frozen with last view I don't think it should have 

a display unless it is active?   
 

40. I would like to have a single postscript file of the User Guide so I can just print it 
out and go through everything. 

 
41. Will users be able to change the relative spacing between beams? Or will Nyquist 

spacing always be required.   
 

42. Probably isn't necessary to mention this but I assume the OT will be expanded to 
include spectral line selection GUIs (e.g. graphical view of the Lovas Catalog) 
and overlaying the chosen region onto a fits file?  Hey, wouldn't it be nice to have 
the region displayed and then be able to click and drag/rotate the corners until it 
looks right?  This would be very impressive! 

 
43. All xml ==> difficult to read.  Is there anyway that some basic project information 

can be written to a comment block at the top of this file that is easier to read?  
Also put in a blank statement that this file can be imported to the ALMA-
ObsTool. 
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44. ETC. has to consider:polarization data, bandpass as well as channel width, noise 
at specified elevation, continuum versus line mode, list of lines in bandpass, noise 
for different spatial reolution 

 
45. I am wondering whether it will be possible to produce and submit  SBs for a 

subsets of a program.  
 

46. I think that the mapper function should be available in an advanced menu (note 
that the word “mapper” can be very confusing).  

 
47. I think that the SB view should be activated only on demand from an advanced 

menu and by default it should be a read only thing. In the same advanced menu 
there could be an option to activate the SB editor mode for expert users. The file 
menu could contain a "verify" button and a “submit” button. 


